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MotionWatch Regulatory Information 
 

Medical Device Directive (European Union) 

 
Manufacturer: 
 
 

 
 

 

US FDA status 
 

Health Canada 
 

Australian TGA 
 

 
 

mailto:technical@camntech.co.uk
http://www.camntech.co.uk/
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IMPORTANT SAFETY INFORMATION  
WARNINGS 

 Coin cell battery – potential swallowing hazard for small 
children! 

 Not Defibrillation proof. 

 Not indicated for use on areas of broken or irritated skin. 

 Devices removed from subjects must be considered to be 
contaminated – see APPENDIX C. 

Safety Classification Information: 

 MotionWatch is INTERNALLY POWERED EQUIPMENT. 

 MotionWatch mode of operation is CONTINUOUS OPERATION. 

 MotionWatch is for PRESCRIPTION USE ONLY (Rx Only) - USA. 

Device and Packaging Symbols and Markings: 

 

MotionWatch 

The MotionWatch is a TYPE B APPLIED 
PART. 
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IMPORTANT BATTERY ADVICE 
 

Battery Replacement 
 
The Motionwatch operates at very low power. When the battery is removed, the 
watch requires some time to fully reset. 
 

It is essential that the battery replacement process is observed 
fully to ensure that any new battery is correctly registered in the 
watch. 
 
Do not fit a new battery without observing the correct 
procedure as detailed in appendix A4. 
 
Always use a new, retail packaged battery – never re-use a part 
used battery. 
 

Always choose a quality branded battery – budget brand batteries have much lower 
energy and can significantly reduce performance. 
 
Failure to observe the correct procedure may result in loss of data. 
 
 

Battery Storage 
 
The Motionwatch uses a CR2032 coin cell battery: 
 

 
 
NEVER Store loose batteries together – they will short and 
may generate heat. 
 
Shorted batteries can no longer be used and should NOT 
be fitted to the MotionWatch. 
 
Poor storage may result in loss of data 

 
 

Choking/Swallowing 
Hazard 
 

 
 
 
 
 
 
 

 
 
 
   

NEVER allow young children to have access to an open 
MotionWatch as the battery may be a choking or 
swallowing hazard. 
 
In normal use the watch closure should be sufficient to 
prevent a child opening and accessing the battery. 
 
If the case lid becomes loose, do not use the watch with 
young children and seek assistance from CamNtech. 
 

! 
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1 Introduction to the MotionWatch System 
 
 

1.1 An Overview of 
the MotionWatch 
System 

The MotionWatch is a compact, lightweight, body-worn 
activity monitoring device that may be used to document 
physical movement associated with applications in 
physiological monitoring. The device is intended to monitor 
limb or body movements during daily living and sleep. The 
MotionWatch can be used to assess activity in any 
instance where quantifiable analysis of physical motion is 
desired. MotionWare allows for the set-up, download and 
analysis of data captured with the MotionWatch. The 
MotionWatch also incorporates a light sensor to record 
luminous intensity (lux) of white light and an event marker 
button. Utilizing the latest low-power MEMs technology, 
the MotionWatch provides a convenient, flexible platform 
for Actigraphy studies of all sizes. See Appendix D – 
Technical Specifications for Technical and operational 
specifications. 

 
Components Required for a System 

A MotionWatch system consists of 2 elements:  
 

 One or more MotionWatch devices. 

 PC based MotionWare Software providing set-up, 
download and analysis functions. 

 
Note that no reader or interface is required – the 
MotionWatch has a direct USB connection. 

 
The MotionWatch 

 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Light sensor 

Status Indicator 

Event Marker Button 
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Event Marker: The MotionWatch has a front-panel button 
that may be pressed by the subject to mark specific 
events. Typically this will be used to mark when the subject 
goes to bed and when the subject gets up in the morning. 
The use of the marker will insert a date/time stamped mark 
within the data. 
Light Sensor: The MotionWatch has a front-panel ambient 
light sensor which can optionally be enabled to collect 
indoor or outdoor light exposure. This function is also 
useful to observe the ‘lights out’ period during sleep. 
Status Indicator: Provides visual feedback by flashing 
when the event marker is pressed. Also used to indicate 
USB connection and during the battery replacement 
process. 

 
Opening the MotionWatch Casing 

The MotionWatch utilises a ‘twist-lock’ casing which 
provides a waterproof seal for the electronics and USB 
connection while facilitating easy access to the battery. 
To open the casing, grasp the front of the watch by the two 
finger grips and rotate anti-clockwise by approximately 
15 degrees to release. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
WARNING!  
DO NOT ATTEMPT TO FORCE OPEN/CLOSED THE 
MOTIONWATCH CASING WITHOUT TWISTING TO 
UNLOCK/LOCK. DOING SO WILL DAMAGE THE 
CASING AND INVALIDATE THE WARRANTY! 
 
Now gently lift out the front section of the casing… 
 
 
 
 
 
 
 
 
 
 
Then turn over to access the USB connection… 
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When the MotionWatch is connected for the first time, the 
USB drivers will automatically be installed (see Section 2.4 
Installing the USB Drivers). 
 

Closing the MotionWatch Casing 

The casing must be closed with the parts correctly aligned. 
To aid with alignment, coloured indicators have been 
provided as shown in the figure below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With the indicators aligned, drop the top part of the casing 
into the lower part and then turn clockwise by 
approximately 15 degrees to close. 
 
WARNING!  
DO NOT ATTEMPT TO FORCE OPEN/CLOSED THE 
MOTIONWATCH CASING WITHOUT TWISTING TO 
UNLOCK/LOCK. DOING SO WILL DAMAGE THE 
CASING AND INVALIDATE THE WARRANTY! 
 
 
 
 

USB Connection 

Alignment Indicators 
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1.2 MotionWatch 
Rugged Model 

 
 
The MotionWatch R (Rugged) is a ruggedized version of 
the standard MotionWatch intended for use in harsh 
environments such as veterinary or military applications. 
The electronics are identical to the standard MotionWatch 
but the casing is all-metal to provide additional strength 
over the standard plastic casing. The Rugged case does 
not include the marker button or light sensor. 
 

Opening the MW Rugged Casing 

The MotionWatch R casing is secured with four Philips 
head screws. To open the casing, carefully remove the 
four screws using the micro screwdriver provided (See 
photo). Take care not to lose the screws: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
Gently lift away the front cover taking care not to lose or 
damage the O-ring seal. 
The electronics module is enclosed within a plastic 
housing (see photo below). 
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Now simply lift-out the electronics module to reveal the 
USB connector and the Battery. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When the MotionWatch is connected for the first time, the 
USB drivers will automatically be installed (see Section 2.4 
Installing the USB Drivers). 

  

O-ring seal 

Electronics Module 

USB Connection 
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Closing the MW Rugged Casing 

To ensure that the MotionWatch R maintains correct 
accelerometer orientation, the casing has two alignment 
features. 
 

 Features on the plastic electronics module housing. 

 Alignment screw on the casing lid. 
 
Insert the electronics module into the lower casing and 
ensure that the features on the plastic part are aligned as 
shown with the yellow highlight below. Note also the 
position of the alignment screw highlighted in red below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With the internal features correctly aligned, gently press 
the lid down; it will fit with a positive click and be aligned 
flush with the lower casing if the alignment is correct. 
Finally re-insert the four Philips head screws and tighten 
down gently – do not over-tighten as the thread may be 
stripped! 
 
 
 
 

Alignment screw 
fits into the recess 
on the lid 

Features on the 
plastic fit into the 

recesses inside 
the lid 

Inside 
view  
of lid 
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1.3 Indications For 
Use 

 
The MotionWatch is a compact, lightweight, body-worn 
activity monitoring device that may be used to document 
physical movement associated with applications in 
physiological monitoring. The device is intended to monitor 
limb or body movements during daily living and sleep. The 
MotionWatch can be used to assess activity in any 
instance where quantifiable analysis of physical motion is 
desired.  
 

1.4 Contraindications 
The MotionWatch is indicated for use on healthy, 
undamaged areas of skin. Where the patient has a history 
of skin irritation, a device should be worn for a brief period 
to test for skin irritation prior to commencing any recording. 
Any device in close contact with the skin can trap sweat or 
moisture and cause redness or slight skin irritation. If this 
occurs, remove the watch and do not wear it for 2-3 days 
to allow the irritation to clear. 
 

1.5 Required Skills, 
Training & 
Knowledge of 
Intended Users 

It is intended that the device be administered only by duly 
qualified health care professionals, researchers and or 
trained nursing staff, possibly in a hospital environment. 

1.6 General 
Description of 
Use 

The MotionWatch contains a miniature accelerometer to 
allow measurement and recording of physical movement of 
the wrist which provides a close correlation to whole body 
movement. The data are sampled at 50Hz and processed 
into ‘epochs’ of user selectable length. These data are 
stored into an internal non-volatile memory and then 
downloaded for analysis at the end of the study period. 
 
Data recorded by the MotionWatch may be downloaded 
and analysed off-line using the MotionWare Software 
Package.  
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2 MotionWare Software Installation & Settings 
 
 

2.1 System 
Requirements  

The MotionWare software is typically supplied on a CD-
ROM or USB Memory Stick containing all of the 
components required to install the software package. The 
following are the minimum requirements of a host PC for 
installing the MotionWatch software:  
 

 Windows 7, 8 or 10; 32 or 64bit operating systems 

 IBM compatible 2GHz + processor speed 
recommended 

 100 MB hard disk space 

 One free USB port 

 A CD-ROM or DVD drive for software installation 

 Graphics SVGA(1280 x 1024) recommended 

 
The software has NOT been tested with any MAC OS. 

 

2.2 Installing the 
Software 

Place the CD ROM into the drive (or insert the USB stick 
into a free port); the MotionWare software installation 
menu should start automatically as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
If it does not start automatically (this functionality has 
sometimes been disabled for security reasons) you will 
need to browse with Windows Explorer to view the CD 
ROM or USB stick then double-click on the file 
‘SplashScreen.exe’. 
 
Click on the ‘Install MotionWare PC Software’ option. 
Follow the installation wizard’s onscreen prompts until the 
installation is complete.  It is recommended that you install 
the software in the default location.  The operation of this 
software on a remote server is not guaranteed as network 
settings vary considerably. The MotionWare software 
requires the Microsoft .Net Framework to be installed; the 
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installation wizard will check and install this if required. 
This may result in a protracted installation procedure. 
 
For USB driver installation see Section 2.4 Installing the 
USB Drivers below. 

 

2.3 Updating the 
Software 

For software versions 1.2.1 and higher, it will not be 
necessary to remove the old software before installing a 
new version. Note that any data and settings are not lost 
during re-installation. 

 

2.4 Installing the 
USB Drivers 

This section on installing drivers only applies to new 
installations. 

 

 The MotionWatch utilises generic Windows USB 
drivers which are provided as part of the Windows 
operating system. 

 To install the drivers, attach the supplied USB cable to 
a free USB port and connect to the MotionWatch. 

 Depending upon the version of Windows, a sequence 
of messages similar to that shown below will be displayed 
at the bottom of the screen: 

 
 

 
 
 
 
 
 
 

 
If prompted, you may be required to restart the PC. 
 
The driver installation is now complete. 
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2.5 Software Serial 
Number 

Double clicking on the MotionWare icon on the Windows 
desktop will start the software.  
The software will run for a 30 day evaluation period and 
then the software serial number will be required. 
If you do not already have a serial number you will need to 
register the software. To check or enter the software serial 
number, open the Settings window ( Settings), then 
click ‘View or enter software serial number’. To initially 
register, please click the ‘Get Serial Number’ button to link 
to the CamNtech website (note: you will need the 
reference number supplied on the CD or media). 
 
When you have received your serial number, enter the 8 
digits and then click the ‘Apply Serial Number’ button. 
 

 
 

2.6 Running the 
Software – 
Main Screen 

Double clicking on the MotionWare icon on the Windows 
desktop will start the software. If a MotionWatch is 
connected it will be automatically detected and the 
MotionWatch Manager screen will be displayed. The front 
screen of the software with no MotionWatch connected will 
be similar to that shown below: 
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2.7 MotionWare 
Settings 

Click on the Settings button  on the start-up screen to 
open the MotionWare settings Window: 
 

 
 

View or Enter Software Serial Number 

Click this button to open the serial number entry window, 
see section 2.5 above 
 

Set Institution Name 

You may also choose to enter an institution name in the 
settings window, which will then be included near the top 
of all printed reports. This may be desirable if you wish to 
hand the actogram or other reports directly to participants 
after use. 

 

Warn of Firmware Updates 

New firmware (software that is programmed into the 
MotionWatch) is sometimes provided within the software 
update. Check the ‘Warn if new firmware available’ 
selection to be automatically notified if new firmware is 
available. 
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It is recommended to check and update the MotionWatch 
firmware following a software update – see Appendix A2 - 
Firmware Update 
 

Default Action for Recent items 

Choose whether to open the data with either Sleep 
analysis or Daytime Activity Analysis upon double click in 
the recent items list. 
 

Automatically show the MotionWatch Manager… 

Controls whether or not to automatically show the 
MotionWatch Manager Window when a MotionWatch is 
connected to the computer. 

Updates 

See section 2.9. 
 

Save Settings and Exit 

Click the ‘Close’ button to save the new settings – note 
that a check for updates will be immediately performed if 
the selection is checked. Click the close [x] icon at the top 
right to close the window without saving the settings. 

 
 

2.8 Bulk Raw Data 
Export 

This function allows you to export the raw data from every 
motion file in a directory into corresponding csv files.  It 
may be useful if you wish to analyse the data yourself 
rather than using the MotionWare software.  You may 
choose the directory to target using either the directory 
browser window, or the file browser to choose an example 
from that directory. 
 

2.9 Bulk Result 
Export 

The Bulk Result Export will export all of the analysed 
recordings in a folder, producing a single row of results per 
recording. Results where there are multiple periods will 
have their results averaged into a single set. This applies 
to the Sleep, Day, Nap and NPCRA (if applicable) 
functions.  
 
Note: It is recommended to analyse your recordings fully 
before using this function for maximum usefulness. 
Recordings which have not been analysed will produce 
empty results in the export for the particular set(s) of 
results. 
  
To open the Bulk Result Export window, click on the Main 
Menu button and then select the Bulk Result Export 
menu item ( Bulk Result Export). 
 



MotionWatch & MotionWare User Guide: Issue 1.2.26 Page 21 
 

2.10 Updates 
 

Checking for Updates 

Your web login information is required before updates can 
be downloaded. To do enter this information, open the 
Settings window ( Settings), and enter your user name 
and password in the specified fields. Click the Save & 
Close button to save the information. 
 
To check for updates, click on the menu  button and 
select the Check for Update menu item, or alternatively 
click the Check for Update button on the Settings 
window. 
 
If a new version is available following dialogue will be 
shown: 
 

 
 
Click the Yes button to start the download. This will 
produce the following window: 
 

 
 
When the download has completed, click the Exit & Run 
Update button to close the application and initiate the 
installer. 
 

Automatically Check for Updates 

Tick this checkbox if you would like the application to 
automatically check for new versions once a day. 
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3 The MotionWatch Manager 
 
3.1 MotionWatch 

Current Set-up 
With the MotionWare Software already started, connect a 
MotionWatch to the USB cable; the watch will 
automatically be detected and the ‘MotionWatch Manager’ 
screen will be displayed as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If a MotionWatch is connected but the above screen is not 
shown, click on the ‘MotionWatch Manager’ button on the 
front screen. 
 
The MotionWatch Manager screen is automatically closed 
when the MotionWatch is disconnected. 
 
The MotionWatch setup options will be explained in detail 
in the following section. 

 
 
 
 
 
 

3 MAIN OPTIONS: 

Setup Watch: click to start a new 
MotionWatch setup (Section 3.2) 

Read Data: click to download the data from 
the MotionWatch (Section 4.1) 

Exit: Close the MotionWatch Manager 
window. 

CURRENT SETUP INFORMATION 

Details of the current set-up stored in the 
MotionWatch. 

UTILITIES TAB 

Click to view/edit advanced functions 
(Appendix A) 



MotionWatch & MotionWare User Guide: Issue 1.2.26 Page 23 
 

3.2 Applying a 
New Set-up 

Click the ‘Setup Watch’ button, the new setup tab is 
activated and the settings may now be edited: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Apply Setup 

Having entered your required setup information, click the 
‘Apply Setup’ button to write the setup to the watch. 
Observe the message window for the confirmation 
message and then disconnect the watch. If any setup 
warnings are shown, consult the troubleshooting section in 
Appendix B. 

 
Immediate or Delayed Start 

Select ‘Immediate Start’ to ensure that the MotionWatch 
begins recording straight away. The start date and time are 
taken from the PC clock so please ensure that this is 
correct. A delay of up to 2 minutes is added to the current 
time and the recording will start on a complete minute. If 

NOTE: The software will warn if data has not been 
downloaded when applying a new setup. If the data is 
NOT required, select ‘Yes’ to continue the setup. If the 
data is required, select ‘No’ and then download the 
data. 
 

User ID: Enter characters to identify the 
subject/patient/study. 

Full Name: [optional] Enter characters to identify 
the patient/study. Note that the maximum length is 
64 characters shared between user ID and Full 
Name. 

Gender: Use the dropdown to select M, F or X (if 
gender is to be undisclosed). 

Date of Birth: Use the date control to enter the 
date of birth of the subject. 

Start Date & Time: Select delayed start to begin 
a recording up to 30 days in the future. Immediate 
start will begin in 1-2 minutes after disconnection. 

Recording Mode: Use the drop down control to 
select the recording mode. 

Light Recording: Check the box to enable light 
recording (Not available on rugged model). 

Compress Data: Check the box to compress the 
activity data (see below). 

Body Position: Choose the mounting location of 
the MotionWatch. 

Epoch: Use the drop down to select the required 
recording epoch. 

Recording Length: Shows the expected 
maximum length of the recording based upon the 
chosen settings. 

Battery Life: Indication of approximate battery life 
remaining in % and colour coded battery gauge. 
Hover over with the mouse for more information. 

Disable Marker Button: Allows the event marker 
button to be disabled. (Not available on rugged 
model). 
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for example the set-up is applied at 16:46:27, the delay will 
be one minute and 33 seconds and the recording will begin 
at 16:48:00. 
Select ‘Delayed Start’ to show the start date/time controls. 
This option allows the recording to be delayed for up to 30 
days into the future. Use the date, hours and minutes 
controls to select the required start date and time. 

Recording Mode 

The MotionWatch offers the following recording modes: 

 MotionWatch Mode 1 – This is an epoch based 
recording mode designed to produce similar 
behaviour to legacy Actiwatch and similar products, 
using a single axis algorithm and peak detection.   

 Tri-Axial Mode 3 – This is an epoch based 
recording mode that uses all three of the 
accelerometer axes to produce a vector magnitude 
result per epoch. This mode is used for recording 
daytime activity when the watch can be mounted at 
other locations on the body (See body position 
below). Note that this mode will shorten the battery 
life as there is more data processing. 

Body Position 

For daytime activity analysis it is recommended to note the 
location upon the body where the MotionWatch is 
mounted. The physical mounting position will have an 
effect upon the data (e.g. data from the wrist will differ from 
that recorded at the waist). This is an optional field that 
does not affect the data processing.  
 

Epoch 

The epoch is the duration for which the MotionWatch will 
accumulate samples before storing the result in memory. 
For example, using a 1 minute epoch, one result will be 
stored in memory every one minute. The MotionWatch 
offers the following epoch length options: 
 

1, 2, 5, 10, 30, 60 seconds. 

 
Note: the algorithms used for sleep analysis are validated 
using a 30 second epoch. 

Light Recording 

The MotionWatch has a built in ambient light sensor. Light 
recording may be enabled or disabled by checking or 
unchecking the ‘Record light’ checkbox during setup. 
When enabled the MotionWatch will store light values in 
lux at the same epoch as the activity samples. The light 
sensor records white light with a response optimised to 
match the human eye. The light is sampled once per 
second and averaged over the epoch. The results are 
stored as lux values. 
Light recording is not available on the MotionWatch R 
(Rugged) model. 
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Recording Lengths 

The MotionWatch calculates and displays the expected 
recording length as the settings are changed. The 
recording mode, epoch, light settings and compression will 
all affect the maximum recording length. The following 
table provides the recording lengths for MW Mode. 
 

Epoch  
(Seconds) 

Activity 
Only (days) 

Activity & 
Light (days) 

Activity 
Compressed* 

1 3 1.5 6 
2 6 3 12 
5 15 8 30 
15 45 23 90 
30 91 46 120 
60 120 91 120 

*see below for details of data compression 

 
Note that for Tri-Axial Mode, the maximum recording time 
is limited to 60 days due to battery life. 

Battery Life Gauge 

The MotionWatch Manager screen shows the battery life 
gauge to provide an indication of remaining battery life 
using a colour coded bar. The bar will change colour to 
provide a clear indication of battery status as the battery 
becomes depleted. The battery life gauge has the following 
indications: 
 
Green   60% to 100%   72 to 120 days (MW Mode) 
     36 to 60 days (Tri Mode) 

 
 
Yellow   40% to 59%   48 to 71 days (MW Mode) 
     24 to 35 days (Tri Mode) 

 
 
Orange  20% to 39%   24 to 47 days (MW Mode) 
     12 to 23 days (Tri Mode) 

 
 
Red   0% to 19%   0 to 23 days (MW Mode) 

0 to 11 days (Tri Mode) 

 
 
When the battery life falls below 15%, the gauge will flash 
and an additional message will be displayed in the status 
area (as shown above).  
 
ALWAYS REPLACE THE BATTERY IF THE RECORDING 
IS LONGER THAN THE EXPECTED BATTERY LIFE. 
If set-up is attempted with a short battery life, an additional 
warning message will be displayed. 
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Battery Life 

The MotionWatch uses a standard non-rechargeable 
CR2032 coin cell which is easily replaced by the user 
(Appendix A4 - Changing the Battery). The MotionWatch 
incorporates smart battery monitoring to measure actual 
device usage and battery voltage to calculate an expected 
life remaining. Typically the expected battery life will be 4 
months (MotionWatch Mode), 60 Days (Tri-axial Mode) 
and the battery life indication will provide a percentage of 
life remaining. Hovering over the battery life in either the 
current or new setup screens will show the expected 
battery life in days in the information pane of the 
MotionWatch Manager. 
The MotionWatch monitors several parameters to 
automatically detect when a new battery is fitted. 
The watch will shut down when the battery is depleted – 
light recording will cease before activity recording. 
Other factors such as operating temperature can 
significantly reduce the battery life. 
The MotionWatch requires some time to shut down fully 
and restart when the battery is replaced. Always follow the 
steps for battery replacement in Appendix A4. The correct 
battery replacement process is CRITICAL and data 
may be lost if not completed correctly. 

 
Compress Data 

It is possible to compress the activity data to allow longer 
recordings at shorter epochs. The light data is not 
compressed. The function uses a logarithmic compression 
which provides lower accuracy with higher values 
(quantized data). At low levels, the accuracy is not affected 
hence for sleep analysis the compression function will 
have minimal effect upon data. Note that the validations 
were performed without data compression. 

Disable Marker Button 

Select to disable the marker button. Not available on the 
MotionWatch R (Rugged) model. 
 

Recommended Setup for Sleep Recording 

The recommended settings for sleep recording are: 

 MotionWatch Mode 1 

 30 second epoch 
These are the settings with which the validation studies 
were performed. It is possible to use other settings if 
required including tri-axial mode. 
 

Recommended Setup for Daytime Activity Recording 

The recommended settings for daytime activity recording 
are: 

 Tri-Axial Mode 3 

 Any epoch 
Also set the body position during set-up so that this is 
noted within the data. 
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4 Downloading Data 
 

4.1 MotionWatch 
Download  

Connect the MotionWatch and then from the MotionWatch 
Manager Window click on the ‘Read Data’ button. The 
download will begin and the progress notification will be 
displayed… 
 
 

 
 

 
 
 
 

If the data download is not required, click the cancel button 
and the operation will be aborted. 
 
When the all data has downloaded (full memory will take 
less than 1 minute) the ‘Save Recording…’ dialog will open 
to allow the data to be saved. 
 
 
Note that the recorded data in the MotionWatch is not 
erased after download; It is only erased when the watch is 
set up again. 
 

4.2 Saving 
MotionWatch 
Data  

Upon completion of the download, the ‘Save Recording…’ 
dialog will open automatically to allow the data to be 
saved. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

IMPORTANT! – ALWAYS MAKE REGULAR BACKUPS 
OF YOUR DATA 
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This window allows the destination for the file save to be 
specified. Type the name of the file as required and click 
the ‘Save’ button. The file will be saved in the default 
*.MTN format. If you do not wish to save the file, click the 
‘Cancel’ button to return to the MotionWatch Manager. 
 
Note that the MotionWatch Manager will not automatically 
close when the MotionWatch is disconnected if data has 
been downloaded and not saved. This serves as a 
reminder to save the data; you may manually close the 
window if the data is not required. 
 

4.3 Shutdown after 
Download  

The MotionWare software defaults to shut-down the 
MotionWatch into sleep mode to save the battery following 
download. Data will NOT BE LOST but the watch will 
cease recording. It is possible to disable this function such 
that the MotionWatch will continue to record following 
download and disconnection (see Appendix A3 - Shutdown 
Options). 
 
NOTE! The MotionWatch cannot record movement data 
whilst connected to the PC. If a continuous recording is 
desired then the watch should be removed from the USB 
cable and returned to the subject as promptly as possible. 

 

4.4 Join Files 
It is possible to join (Concatenate) two MotionWatch 
recordings to create a single recording. The recordings 
must contain the same user details/setup and be 
concurrent. 
 

1. Load the first data file for sleep analysis by 
selecting from the list of recent recordings or by 
browsing for Motion file. 

2. From the ‘file’ menu select ‘Join…’ 
3. In the file dialogue, browse and/or select the 

second motion file that is to be joined to the first. 

4. A save dialogue will open to allow the file name 
and location for the joined file to be specified. 

5. Click save to save the new file – both original files 
will be kept unless the joined file is given the same 
name (an overwrite warning will be given in this 
case). 

6. The new joined file may now be loaded from the 
recent recordings list. 

7. Any gap between the two recordings will show as 
‘missing data’ and will be marked in grey. 
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5 Preparing to Analyse Data 
 

5.1 Selecting Recent 
Recordings 

When data is saved following download, the file 
automatically appears in the ‘Recent Recordings’ list on 
the front screen of the software. The recent recordings list 
provides a quick access method to the most recently 
opened or downloaded files. 
 
It is possible to adjust the recording for daylight saving – 
see section 5.13 below for more information. 
 
Click once on a file in the list to select it; more details of 
the file are displayed in the information pane below. The 
file can be opened after selection by clicking on the ‘Open 
selected recording’ button. Alternatively, double clicking on 
the file will open the file directly (choose which analysis 
type to open with double click in MotionWare Settings). 
Right click on the file for more options. 
 
 
 
 
  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.2 Managing Recent 
Recordings 

If the recent recordings list becomes full or cluttered, it is 
possible to remove entries from the list or to fully delete the 
related file. To manage the recent recordings, right click on 
the required file name in the list to show a pop-up menu 
with the following options: 
 

 Open in Sleep Analysis 

 Open in Day Analysis 

Recent Recordings: Click an item to 
view the file details in the information 
pane then open by clicking the Open 
Selected Recording button. 
Alternatively, double click an item to 
open directly. 
Where a file is a legacy file-type, this 
will be shown in the list entry. 

Open in Sleep Analysis: Click to 
open the item selected in the Recent 
Recordings list with Sleep Analysis. 

Information Pane: Provides more 
detail about the selected recording. 

Open in Day Analysis: Click to open 
the item selected in the Recent 
Recordings list with Daytime Activity 
Analysis. 

Browse for Motion File: Opens file 
manager dialog to select a file. 
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 Properties 

 Remove From List 

 Delete File 

 Clear Recent Items List 

Select ‘Remove from list’ to keep the file on the disk but 
remove it from the list; the file will not be deleted. Select 
‘Delete File’ to remove from the list and delete the file from 
the disk. A warning message will be displayed before the 
file is permanently deleted. 

Select ‘Clear Recent Items List’ to remove all files from the 
list – the files will not be deleted. 

Clicking ‘Properties’ allows the recording details to be 
viewed. 

5.3 Browse for 
Recordings 

It is also possible to locate and load recordings that do not 
appear in the Recent Recordings list. From the main 
screen, click on the ‘Browse for Motion File’ button to open 
a standard Windows File dialogue. Use the folder controls 
to browse to the location of the required files. Note that the 
default file format is .MTN (depicting MoTioN) and this type 
of file will be displayed automatically. It is possible to 
change the file-type filter to browse for other file types (see 
below). 

 

5.4 Import Legacy 
Recordings 

As certain legacy products (such as CamNtech Actiwatch) 
used an open file format, it is possible to import existing 
.AWD format files. To import a legacy file, follow the 
instructions to browse for a file in Section 5.3 above and 
then change the file-type filter to ‘Actiwatch (*.AWD)’: 
 
 
 
 
The table below lists the compatibility with various 
Actiwatch model data: 
 

Actiwatch Model Compatibility 

Actiwatch 7 Y 
Actiwatch 4 Y 

Actiwatch Light Plus Y 
Actiwatch Mini Y 

Actiwatch Spectrum Y
1
 

Actiwatch 2 Y
1
 

 
 
1 It is not possible to directly open this type of file but it is 
possible to export data from the Actiware Software in .csv 
format and then use the csv import utility to re-save the data 
in compatible format (see Appendix E1 – CSV Import Utility). 
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5.5 The 
MotionWise 
Window 

When a recording is opened the MotionWise window is 
displayed: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The MotionWise window provides a multiple-day, single or 
double plotted motion graph (actogram) within a flexible, 
scalable and scrollable window. The MotionWise window is 
the key tool for the selection of data for more detailed 
analysis. The top region of the window provides summary 
patient information. The entire window may be stretched 
and dragged by manipulating the corners of the window. 
The window can also be maximised to fill the full screen by 
using the window control. 
 
Scroll through the days by using the slider control at the 
right hand side of the screen or by using the mouse scroll 
wheel. 
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5.6 The 
MotionWise 
Graphs 

For each day containing data, a graph similar to that 
shown below will be displayed.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

5.7 MotionWise 
Graph View 
Options 

The Actogram view can be adjusted for different purposes 
using the window below. This is found under the ‘Options’ 
item in the ‘View’ menu. The Actogram will adjust to give 
immediate feedback after you have changed any of the 
options. 
 

 
 
Row Length 

Select 24 or 48 hour graphs to show single day or double 
day plotted graph respectively. Each row of the graphs will 
then correspond to the length chosen, but the change 
forwards between rows will be 24 hours in both cases. 
 

Reduce 
Activity 

Scale 

Reduce 
Light 
Scale 

Increase 
Activity 

Scale 

Increase 
Light 
Scale 

Activity Plot 
(Black) 

Light Plot 
(Yellow) 

Event Marker 
(Blue) 

No Data 
(Grey) 
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Row Height 

Using this slider, you can adjust the heights of each row of 
the Actogram to show lots of detail on each graph, or very 
compressed rows to present a longer time period 
onscreen. Note that the range available here depends on 
the setting of the ‘Horizontal scale’ below.  
 

Start Rows at 

The MotionWise graphs default to a plot start time at the 
start of the recording. However, when comparing data 
between multiple users, it can be useful to have a fixed 
start time for the plots. So you can select either to always 
start from the beginning of the recording, or enter a fixed 
time in the text box. 
 

Horizontal Scale 

Using this option, you can choose to show self-contained 
graphs with a horizontal scale on each row, or close-fitted 
graphs with no horizontal axis on each. In the latter case, a 
time scale is added at the top and bottom of the actogram 
instead. 

Finer Detail Grid Lines 

Show or hide the light grey hourly grid lines on the graphs 
(these will also depend upon the resolution of the monitor 
or printer). 

Annotations 

The marker lines or highlighted periods on the graph can 
be shown at full graph height or just at the top of the graph. 
This can help to make the graph more clear when there 
are many marker events and selected periods. 

5.8 Printing the 
MotionWise 
Graphs 

You may produce a printed copy of the MotionWise graphs 
covering all days of data, by selecting the ‘Print preview” 
option from the ‘File’ menu. This preview allows you to 
view and step through all of the report pages using the 
‘Prev’ and ‘Next’ buttons.  
 
The printed Actogram can be adjusted similarly to the on 
screen Actogram by clicking the ‘Actogram Options’ 
button. This includes an additional setting to include or 
exclude a list of the recording properties with the Actogram 
printout. 

5.9 Selecting the 
Analysis 
Period 

There are three main selection options which may be 
chosen by use of the control buttons in the MotionWise 
window: 
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Select Any 

The ‘Select Any’ option provides a flexible means of 
selecting any analysis period between your chosen start 
and end points. 
 
In the MotionWise window, choose the period of data for 
analysis by pointing at the start point, hold down the left 
mouse button and then drag to select the period required. 
The selected period is highlighted and the Analysis window 
is automatically displayed. The figure below shows a single 
overnight period selected: 
 
 
 
 
 
 
 
 
It is possible to select a very short period (i.e. a few 
minutes) to several days using this method. By dragging 
off the bottom or top of the MotionWise graph area, the 
window will automatically scroll to allow selection of days 
that are not currently displayed. 
 

Select Days 

The ‘Select Day(s)’ option will select a period starting and 
ending at midnight on the chosen day(s). To make a 
selection, point anywhere within the graph on the day of 
interest, hold down the left mouse button and then drag to 
select the day(s) required. Drag across multiple graphs to 
select several days and drag off the bottom or top of the 
MotionWise graph area to automatically scroll while 
selecting. 
 

Select All 

The ‘Select All’ option allows a one-click selection for all 
days of data ready for a multiple day analysis such as 
NPCRA. 
 

5.10 Saved Periods 
and Longer 
Periods 

The Analysis functions allow the selected periods to be 
saved. These periods will remain highlighted in the 
MotionWise Window and the analysis can be quickly re-
opened by clicking anywhere in the highlighted region. If 
the saved period is longer than 24 hours (i.e. for an 
NPCRA analysis) then the highlight is not shown in the 
graph. These longer saved periods may be chosen from 
the ‘Long periods’ menu in the MotionWise Window. 
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5.11 Editing Data 
It is possible to edit periods where there is believed to be 
some problem with the recorded data to change or remove 
the activity during that period. This may be necessary 
where for example the watch was not worn for a period, or 
where it is believed an activity gave particularly misleading 
activity counts for analysis purposes. The Edit function 
may be accessed by selecting a period for analysis in the 
manner described in Section 6 Sleep Analysis, then 
selecting the Edit analysis function from the list in the 
bottom-left of the window. 

 
 

After selecting the Edit tool, it is possible to fine tune the 
time period for the edit either by dragging the ‘Start’ and 
‘End’ bars on the graph, or by changing the text boxes 
containing times below the graph. 
 
Next you must choose to change either the ‘Activity’ or 
‘Light’ channel as appropriate. Note that marking missing 
data will cause both to be considered as missing. 
 
The data samples within the selected period can be 
changed in four different ways: 
 

 Missing data – this will set the data as missing, 
where the period is shown with a grey background, 
and analysis functions which take an average will 
ignore the missing samples. 

 Fixed value – this will set the data samples (either 
activity or light) to the value entered in the box. 

 Average of – this will set the data samples to either 
the average of the entire day (including the 
selected period), or the average of the day 
excluding the selected period.  The day is taken as 
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the 24-hour period between midnights which 
contains the start time of the edit. 

 Original data – because all of the data and changes 
are contained as an audit log within the motion file, 
this option allows you to restore the original values 
first recorded before any edit took place. 

 
If the last part of the recording is marked as “Missing data”, 
then this will also reduce the length of the printed 
Actogram to avoid printing unnecessary missing days.  
This is particularly useful if the watch has been left 
recording invalid data for some time after being worn, but 
before download.  In this case, simply select all of the time 
after the valid recording and mark it as missing data.  This 
can be restored at any point using the “Original data” 
option above. 
 

5.12 Generating 
Reports 

In the MotionWise window select ‘Tools -> Report’ to open 
the report generator window. 
 

 
This tool provides a number of flexible reporting options 
which are discussed in more detail below. 
 

Include Recording Properties 

Select this option to include the User ID, Gender, DOB, 
Device information and start time within the report. 
 

Include Markers 

Select this option to include a date/time stamped listing of 
marker events within the report. 
 

Include Sleep Analysis 

Select this option to include full Sleep Analysis results for 
all saved analysis periods within the report (see Section 6 
Sleep Analysis). 
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Transpose Table 

Select this sub-option to swap the row/column layout of the 
report.  
 

Copy with Rounded, Formatted Values 

This sub-option applies to data exported via the clipboard 
only. When selected, the results will contain rounded 
values with periods formatted as hours and minutes. When 
un-selected, the results will be exported as un-rounded 
values and periods will be formatted in seconds. The latter 
option is useful when importing data into external 
packages for further analysis. 
 

Print in Landscape 

This option swaps the default (portrait) report format to 
landscape orientation. This can be useful to best ‘fit’ the 
report to the page. This option only applies to printed 
reports. 
 

Copy Results Tables (for spreadsheet) 

Having selected the required report options, click the ‘Copy 
Results Tables’ button to export the data. The data may 
now be imported into external software (e.g. a 
spreadsheet) for further analysis or formatting. 
 

Copy to Word Processor 

Places the selected results and actograms for all days onto 
the clipboard formatted to paste directly into a word 
processor. This facilitates rapid production of custom 
reports.  
 

Save as (PDF, RTF, DOC, ODT)… 

The selected results and actograms for all days are saved 
into your selected file format. Choose the document type in 
the ‘Save as type…’ dropdown, choose from the following 
options: 

 RTF – Rich Text Format – open in most word 
processors. 

 PDF – Portable Document Format – open in Adobe 
Acrobat Reader. 

 DOC – Microsoft Word Document. 

 ODT – Open Document – use with Open Office. 
 
Enter a file name/location to save the file. These options 
facilitate rapid production of custom reports.  
  

Print Preview 

Having selected the required report options, click the ‘Print 
Preview’ button to view the report on screen before 
printing. 
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The print preview window has a number of formatting and 
zoom options. There is also a ‘Print’ button in the menu to 
allow printing without the need to close the window. 
 

Print 

Having selected the required report options, click the ‘Print’ 
button to send the report to the printer. A standard printer 
dialogue will be displayed allowing the target printer 
options to be selected. 
 

Filter Visible Columns 

It is possible to further 
customise the parameters that 
will be included in the report. 
Click on the ‘filter visible 
columns’ button for either the 
marker or sleep analysis data. 
A window containing a checklist 
of parameters will be displayed 
(sleep parameters are shown in 
this example). Ensure that the 
required parameters are 
checked for inclusion in the 
report. 
 
 
 
 
 
 
 
 
 
 
 
 

5.13 Daylight 
Saving Adjust 

If a clock change is detected (daylight saving) during a 
recording, a message will be displayed upon first opening 
of the recording:  
 
 
 
 
 
 
 
 
 
 
 

 Select ‘Yes’ to apply a daylight saving adjustment 
to the data. This will default to the local regional 
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settings of the computer (typically add or remove 1 
hour of data at 2am.) This can be undone – see 
5.14 below. 

 Select ‘No’ to ignore the daylight saving adjustment 
(Adjustment can be applied later if required) 

 
It is possible to apply the daylight saving adjustment by 
clicking on the ‘Tools’ menu then selecting ‘Daylight 
Savings Adjust’. The following window will be displayed: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The adjustment values can be changed here if required 
and then be applied to the data by clicking ‘Apply now’. 
 

5.14 Restore original 
download 

To reverse (undo) any daylight saving adjustment or any 
other edits or any saved analysis, first close the recording 
and then re-open it. 
Next select ‘Restore original download’ from the ‘Tools’ 
menu. 
A warning will be displayed as follows: 
 

 
 
Click ‘Ok’ to restore the original download or cancel to 
keep the adjusted data. Note that all edits have been made 
to the data, will be lost (including any saved sleep periods 
or analysis).  
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6 Sleep Analysis 
 

6.1 Introduction 
The Sleep analysis function is designed to provide a 
number of objective sleep measures from overnight 
actigraphy data. It can be easily applied either to normal 
overnight periods, or used to examine any sleep period 
from an altered phase recording such as a shift worker.  
First select a region using the MotionWise window 
(see Section 5.9 Selecting the Analysis Period above) 
which includes a short period of daytime activity at the start 
and end. The detailed analysis window will be displayed 
and may initially default to the summary function. To select 
Sleep Analysis, choose ‘Sleep’ from the Analysis Function 
options at the left of the screen. The detailed Sleep 
Analysis window will be displayed:  
 

 
 

It is now possible to drag the ‘Lights Out’ and ‘Got Up’ 
markers to the appropriate positions in the data, and the 
thinner red markers inside which denote ‘Fell Asleep’ and 
‘Woke Up’ will be automatically adjusted from the 
combination of your markings and the activity data. All of 
these four times are also displayed in the information box 
below the graph. 
 

6.2 Sleep Analysis 
Statistics 

Once the desired sleep region is selected, the software will 
automatically perform a categorisation of each epoch of 
the period between ‘Fell Asleep’ and ‘Woke Up’ as either 
‘Sleep’ or ‘Wake’, and also as either ‘Mobile’ or ‘Immobile’, 
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and use these results to provide a number of measures 
from the period.  These are described below: 
 

 Time in bed: The total elapsed time between the ‘Lights 

Out’ and ‘Got Up’ times. 

 Assumed sleep: The total elapsed time between the ‘Fell 

Asleep’ and ‘Woke Up’ times. 

 Actual sleep time: The total time spent in sleep according 

to the epoch-by-epoch wake/sleep categorisation. 

 Actual sleep (%): Actual sleep time expressed as a 

percentage of the assumed sleep time. 

 Actual wake time: The total time spent in wake according 

to the epoch-by-epoch wake/sleep categorisation. 

 Actual wake (%): Actual wake time expressed as a 

percentage of the assumed sleep time. 

 Sleep efficiency (%): Actual sleep time expressed as a 

percentage of time in bed. 

 Sleep latency: The time between ‘Lights Out’ and ‘Fell 

Asleep’. 
 Sleep bouts: The number of contiguous sections 

categorised as sleep in the epoch-by-epoch wake/sleep 

categorisation. 

 Wake bouts: The number of contiguous sections 

categorised as wake in the epoch-by-epoch wake/sleep 

categorisation. 

 Mean sleep bout: The average length of each of the sleep 

bouts. 

 Mean wake bout: The average length of each of the wake 

bouts. 

 Immobile mins: The total time categorised as Immobile in 

the epoch-by-epoch mobile/immobile categorisation. 

 Immobile time (%): The immobile time expressed as a 

percentage of the assumed sleep time. 

 Mobile mins: The total time categorised as mobile in the 

epoch-by-epoch mobile/immobile categorisation. 

 Mobile time (%): The mobile time expressed as a 

percentage of the assumed sleep time. 

 Immobile bouts: The number of contiguous sections 

categorised as immobile in the epoch-by-epoch 

mobile/immobile categorisation. 

 Mean immobile bout: The average length of each of the 

immobile bouts. 

 Immobile bouts <=1min: The number of immobile bouts 

which were less than or equal to one minute in length. 

 Immobile bouts <=1min (%): The number of immobile 

bouts less than or equal to one minute expressed as a 

percentage of the total number of immobile bouts. 
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 Total activity score: The total of all the activity counts 

during the assumed sleep period. 

 Mean activity /epoch: The total activity score divided by 

the number of epochs in the assumed sleep period.  Note 

that this result will be expected to scale depending on the 

length of the epoch. 

 Mean nonzero activity per epoch: The total activity score 

divided by the number of epochs with greater than zero 

activity in the assumed sleep period.  Note that this result 

will be expected to scale depending on the length of the 

epoch. 

 Fragmentation Index: The sum of the ‘Mobile time (%)’ 
and the ‘Immobile bouts <=1min (%)’.  This is an indication 

of the degree of fragmentation of the sleep period, and can 

be used as an indication of sleep quality (or the lack of it). 

 Threshold: The threshold used for analysing movement 

data.  The MotionWatch was validated with a threshold of 

20, but this may be chosen differently depending on the 

population. 

 Rest per 24h (%): The percentage of epochs in a 24 hour 

period which would be counted as sleep if the whole period 

were analysed as night time.  The period runs for 24 hours 

from midday to midday around the “To Bed” time of the 

analysis.  

 Average light (lux): This measure is only present if light 

was recorded.  It is the average light level over the period 

between falling asleep and waking up. 

 Central Phase Measure (mins): This is the midpoint 

between “Fell asleep” and “Wake up”, expressed as the 
number of minutes past midnight.  For ease of normal use, 

it will be negative for phase times prior to midnight but after 

midday. 

 

6.3 Saving or 
Removing 
Analysis 
Statistics 

With the analysis for the period complete, the analysis may 

be saved by clicking on the ‘Save Sleep Period’ button. 

The detailed analysis window will close automatically and 

the analysis period will remain highlighted in the 

MotionWise window. To re-open the saved analysis, 

simply click anywhere on the highlighted region in the 

MotionWise window. 
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If the saved analysis is no longer required, click on the 

‘Delete Sleep Period’ button in the sleep analysis screen to 

remove it. 

6.4 Adjusting 
Analysis 
Threshold 

The threshold used for sleep analysis can be adjusted 

under the ‘Options’ button. Note that the MotionWatch 

system has been validated with a threshold of 20, so this 

should normally be the default choice. 

6.5 Exporting 
Sleep Analysis 
Results 

The ‘Copy Results’ button and ‘Epoch Results’ or 
‘Statistics’ options will allow you to transfer either the 
detailed epoch-by-epoch results or the overall statistics 
easily into a spreadsheet program or similar. Simply click 
the button, transfer to a spreadsheet window on your 
computer, and use the normal Windows paste function to 
create a table of your results. 

6.6 Printing Sleep 
Analysis 
Results 

Click on the ‘Print Preview’ button to preview the report 
and click on the ‘Print’ button to send the report to the 
printer. 
 

6.7 Sleep 
Summary 
Table 

From the MotionWise window, select ‘Sleep Summary 
Table’ from the ‘Tools’ menu. This window provides a 
summary of the saved Sleep analysis periods. 
Furthermore, it is possible to edit the ‘lights out’ and ‘got 
up’ times within this window using patient provided 
information (i.e. a sleep diary). 
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To enter data, highlight the required time and then type in 
the data in HH:MM format. 
 
Click on ‘Save Changes’ when complete and the analysis 
periods will be automatically highlighted in the MotionWise 
window. Click on any highlighted period to open Sleep 
Analysis. This will perform the analysis on the visible data. 
After checking the data and results for any anomalies, you 
must then re-save the sleep period to capture the night’s 
results for the report output. 
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7 NPCRA Analysis 
 

7.1 Introduction 
Traditional analysis of circadian rhythms has attempted to 
fit physiological indicators to a Cosine waveform shape 
(Cosinor analysis). Activity-rest data do not typically fit well 
with this type of analysis, hence the MotionWare software 
provides the function of Non-Parametric Circadian Rhythm 
Analysis (NPCRA). With this approach, we do not assume 
that the data fit any pre-defined distribution. The method 
used is to analyse full-days of data over several days to 
determine some useful variables which are explained in 
more detail below. Studies have shown that the non-
parametric variables are a valuable indicator of rhythm 
disturbances caused by disease or aging and their 
associated treatments. 
 

7.2 Reference 
The NPCRA analysis is based upon the work of Dr. Eus 
Van Someren at the Netherlands Institute for Brain 
Research e.van.someren@nin.knaw.nl 
The original paper published by Dr. Van Someren is: 
 

Van Someren, E J W, DF Swaab, C C Colenda, W 
Cohen, W V McCall, and P B Rosenquist.  Bright 
Light Therapy: Improved sensitivity to its effects on 
rest-activity rhythms in Alzheimer patients by 
application of nonparametric methods.  
Chronobiology Int. (1999) 16 (4) 505-518. 

 

7.3 Analysis 
NPCRA analysis requires complete data from as many full 
days as possible. It is not recommended to attempt 
analysis with less than 7 days of data and best results are 
obtained with 14 or more days. 
 
To select the analysis days, use the ‘Select All’ button in 
the MotionWise screen to automatically select all available 
days. Alternatively, use the ‘Select Days’ or ‘Select any’ 
tools to specify the analysis period (see Section 5.9 
Selecting the Analysis Period).  
 
Note also that the analysis is sensitive to periods of 
inactivity when the MotionWatch has not been worn.  
 
Having selected the analysis period, the analysis window 
will be displayed. Select ‘NPCRA’ from the sidebar 
functions. 
 

mailto:e.van.someren@nin.knaw.nl
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7.4 Non-
Parametric 
Variables 

The NPCRA window provides a table of resulting Non-
Parametric variables with the following meanings: 
 
IS (Interdaily Stability): quantifies the degree of regularity 
in the Activity-Rest pattern with a range of 0 to 1 where a 
value of 0 indicates a total lack of rhythm and a value of 1 
indicates a perfectly stable rhythm. 
IV (Intra-Daily Variability): quantifies the degree of 
fragmentation of activity-rest periods. Typical healthy 
subjects will show a single prolonged activity period and a 
single prolonged rest period per 24 hour cycle. Certain 
physiological conditions may lead to multiple short-length 
periods of activity-rest within any 24 hour period. The 
variable has a theoretical range of 0 to 2 with higher values 
indicating higher fragmentation. Typical values for healthy 
subjects will be below 1. 
L5 (Least 5) Average: all days of data are overlaid and 
averaged in 24-hour periods. The L5 average provides the 
average activity level for the sequence of the least five 
active hours. This value provides an indication of how 
restful (inactive) and regular the sleep periods are. 
L5 Start Hour: Indicates the onset of the L5 sequence and 
provides an indication of the phase of the most restful 
hours. 
M10 (Most 10) Average: all days of data are overlaid and 
averaged in 24-hour periods. The M10 average provides 
the average activity level for the sequence of the highest 
(most) ten active hours. This value provides an indication 
of how active and regular the wake periods are. 
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M10 Start Hour: Indicates the onset of the M10 sequence 
and provides an indication of the phase of the most active 
hours. 
RA (Relative Amplitude): First we calculate the Amplitude 
(AMP) which is the difference between the average activity 
level in the M10 and that in the L5 periods. To remove 
sensitivity to overall activity level, we then calculate the RA 
by dividing the AMP by the sum of the L5 and M10. The 
variable has a theoretical range of 0 to 1 with higher values 
indicating a rhythm with higher amplitude. 
 

7.5 Exporting 
NPCRA 
Analysis 
Results 

The ‘Copy Statistics’ button will allow you to transfer the 
overall statistics easily into a spreadsheet program or 
similar.  Simply click the button, transfer to a spreadsheet 
window on your computer, and use the normal Windows 
paste function to create a table of your results. 
 

7.6 Printing 
NPCRA 
Analysis 
Results 

Click on the ‘Print Preview’ button to preview the report 
and click on the ‘Print’ button to send the report to the 
printer. 
 

7.7 Save NPCRA 
Analysis 
Period 

Click on the ‘Save Period’ button to save the selected 
analysis. Long periods are not highlighted in the 
MotionWise window as they would hide shorter periods 
and become confusing. Instead use the ‘Longer periods’ 
menu from the MotionWise window to select any saved 
periods greater than 24 hours. 
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8 24 Hour Average Plot 
 

8.1 Select Data for 
Analysis 

From the MotionWise window, use the ‘select days’ option 
to choose a range of days or use the ‘select all’ option to 
analyze all days. The analysis window will open 
automatically; if not already selected, select ‘24h Average’ 
from the analysis functions side bar. A screen similar to 
that shown below will be displayed. 
 

 
 

Smoothing Period 

The smoothing period allows a time constant to be applied 
to the plotted data which is useful when analyzing for 
trends. The period may be selected between no smoothing 
and 60 minutes. 

Daytime Period 

It is possible to specify the start and end of the daytime 
period to be used for the analysis. This will affect the 
daytime and nighttime average values accordingly. 

Activity Average 

The data per epoch for each day are day totalized and 
averaged over the number of days in the analysis. The 
average activity in the daytime and nighttime periods are 
then calculated and displayed. Note MW counts are 
MotionWatch counts. 

Day/Night Average Ratio 

This is the daytime activity average / nighttime activity 
average. 

Fitted Cosine Peak 

A cosine is fitted to the averaged data and the time of day 
where the cosine peak occurs is displayed.  
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9 Nap Analysis 
 

9.1 Overview 
The Nap analysis function allows detection of periods of 
inactivity that could be attributed to daytime napping or 
micro-sleeps. The function provides user adjustable 
parameters for duration and threshold to detect the 
potential naps. 
 

9.2 Select Data for 
Analysis 

From the MotionWise window, use the ‘select any’ option 
to a period of data to analyze – this will typically be during 
the normal active daytime period. The analysis window will 
open automatically; if not already selected, select 
‘Napping’ from the analysis functions side bar. A screen 
similar to that shown below will be displayed. 
 

 

9.3 Select Nap 
Activity 
Threshold 

The ‘Napping activity level (/epoch)’ is used to set the 
activity threshold for nap detection. The activity level in 
every epoch within the specified period must be less than 
or equal to the entered value for the period to be scored as 
a nap. For example, if the threshold is set to 10, the period 
will be scored as a nap if every epoch <=10 counts. 
Change the threshold value by typing the number of 
counts. 

9.4 Select Min Nap 
Length 

Set the minimum period of inactivity required to be scored 
as a nap. The value should be typed in the format 
hh:mm:ss. Periods shorter than the selected value will not 
be scored as a nap period. 
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9.5 Select Max Nap 
Length 

Set the maximum period of inactivity required to be scored 
as a nap. The value should be typed in the format 
hh:mm:ss. Periods longer than the selected value will not 
be scored as a nap period. 

9.6 Analysis 
Results 

The analysis window will show the number of potential 
naps detected. The analysis graph will display the potential 
nap periods as green highlighted areas. 

9.7 Export Nap 
Periods 

To export the nap analysis details, click on the ‘Export Nap 
periods’ button. The nap analysis details will be copied to 
the clipboard which may then be pasted into Excel or 
similar for further analysis. 
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10  Day Activity Analysis 
 

10.1 Overview 
 

The day activity analysis function provides an overview 
and summary of the activity levels of the wearer during the 
daytime. It is intended to assist in monitoring of the amount 
of time spent active on a daily or weekly basis, and the 
approximate intensity of that activity.  
 
To use the Day Analysis function, single click to select a 
recording from the recent files list and then click the “Day 
Activity Analysis” button. 
 

10.2 Day Analysis 
Once the recording has been opened with the daytime 
analysis function, the Day Analysis window will show as 
below. It allows you to step through every day of the 
recording and see the highlighted activity periods and daily 
summary data. 
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Selecting Days 

To select which day of the recording to view, note the 
sequence of small day graphs across the top of the Day 
Analysis window. You can click on any of these to view 
that day in more detail below. You can also scroll this 
selection to view more days later in the recording. Days 
which contain some moderate or vigorous activity are 
highlighted with the “M” or “V” stamp respectively on the 
quick selection view. 
 
In addition, the left and right arrows to the right of the day 
calendar, as well as the directional keys on the keyboard 
can be used to step through all days of the recording. 
 

Highlighted Activity Graph 

The main activity graph in the Day Analysis window 
highlights periods of constant activity – those where higher 
levels of movement are maintained for 10 minutes or more.  
You can control whether moderate and vigorous periods 
are highlighted in this way using the View menu of this 
window.  
 

Summary Activity 

Below the main activity graph, a bar chart summarises the 
amount of time spent in constant activities of vigorous, 
moderate or low intensity alongside sedentary time. The 
table of results below this includes both the constant totals 
drawn in the bar chart and highlighted on the activity graph 
(where only 10 minute or greater periods are counted), and 
the total times in each category (where every epoch is 
counted). 
 

Definition of Results 

The following tables describe the criteria used when 
categorising time expenditure:  
 
Vigorous Activity 
Time 

The total amount of time when 
the activity count exceeds the 
‘Vigorous’ calibration threshold. 

Moderate Activity 
Time 

The total amount of time when 
the activity count is greater than 
or equal to the ‘Moderate’ 
calibration threshold and is less 
than ‘Vigorous’ threshold. 

Low Activity Time The total amount of time when 
the activity count is greater than 
or equal to the ‘Sedentary’ 
calibration threshold and is less 
than ‘Moderate’ threshold. 

Sedentary Activity 
Time 

The total amount of time when 
the activity count is greater than 
zero and is less than the 
‘Sedentary’ threshold. 
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Empty Time The total amount of time when 
the recording did not take place 
– such as at the start or end of 
the recording (for example the 
difference between 00:00 and 
the start time or the end time and 
24:00). 

Non-zero Time Any data within the recording 
with a count value above zero. 

Zero Time Any data within the recording 
with a count value of zero. 

 
If the ‘Show Only Continuous Activity’ option is checked 
under the ‘View’ menu, ‘Vigorous Activity Time’ and 
‘Moderate Activity Time’ are replaced with: 
 
Continuous Vig. 
Activity 

As ‘Vigorous Activity Time’, but 
only when the amount of time is 
10 minutes or more. 

Continuous Mod. 
Activity 

As ‘Moderate Activity Time’, 
but only when the amount of 
time is 10 minutes or more. 

 
 

10.3 Set Calibration 
It is possible to set the calibration for the intensity of 
activity used in classification. This can be done by clicking 
the Tools menu on the Day Summary and selecting the 
“Set Calibration” function.  

 

The analysis function uses a calibration to derive reference 
thresholds for vigorous, moderate, low and sedentary 
activity types. These values differ from patient-to-patient 
depending on their capabilities, so it is desirable to perform 
a calibration for each patient or recording (where 
applicable). 

 
The best way to calibrate a recording is to arrange for the 
patient to perform a brisk walk (3-4 mph) for at least 5 
minutes. This should take place at the start, or at the end 
of a recording to ensure that it is easily identifiable when 
selecting it in the calibration window [1]. 
The calibration period can be selected by either clicking 
the highlighted period in the activity graph [2], or by 
selecting a reported period in the detected periods list [3]. 
The selected period will use an average of the activity 
counts found within the period to produce the moderate 
threshold. This value will also be used to derive the 
vigorous and sedentary thresholds. The low threshold 
accounts for any values found between the sedentary and 
moderate thresholds.    

 
The entire recording will be analysed to detect any bouts of 
activity which are longer than 5 minutes and who’s activity 
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counts are within an acceptable range. These can be 
selected as alternative calibration values but they may not 
reflect the values of a brisk walk and should be used with 
caution. Calibration periods can also be selected manually 
by dragging the mouse cursor over a period on the activity 
graph, or by entering fixed values in the thresholds fields 
[4].  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[1] Calibration Window [2] Detected Calibration Period 

[3] Detected Calibration List [4] Threshold Fields 
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Definition 
Physical activity includes everyday activity such as walking and cycling to get 
from A to B, work-related activity, housework, DIY and gardening. It also 
includes recreational activities such as working out in a gym, dancing, or 
playing active games, as well as organised and competitive sport. (See the 
Chief Medical Officers' [CMOs'] report.) 
National recommendations 
The CMOs' current recommendations for physical activity (see UK physical 
activity guidelines) state that: 
 

 All adults aged 19 years and over should aim to be active daily. 

 Over a week, this should add up to at least 150 minutes (2.5 hours) of 

moderate intensity1 physical activity in bouts of 10 minutes or more. 

 Alternatively, comparable benefits can be achieved through 75 minutes of 

vigorous intensity2 activity spread across the week or combinations of 

moderate and vigorous intensity activity. 

 All adults should also undertake physical activity to improve muscle strength 

on at least 2 days a week. 

 They should minimise the amount of time spent being sedentary (sitting) for 

extended periods. 

 Older adults (65 years and over) who are at risk of falls should incorporate 

physical activity to improve balance and coordination on at least 2 days a 

week. 

 Individual physical and mental capabilities should be considered when 

interpreting the guidelines, but the key issue is that some activity is better 

than no activity. 

1 Moderate-intensity physical activity leads to faster breathing, increased heart 
rate and feeling warmer. Moderate-intensity physical activity could include 
walking at 3–4 mph, and household tasks such as vacuum cleaning or 
mowing the lawn. 
2 Vigorous-intensity physical activity leads to very hard breathing, shortness of 
breath, rapid heartbeat and should leave a person unable to maintain a 
conversation comfortably. Vigorous-intensity activity could include running at 
6–8 mph, cycling at 12–14 mph or swimming slow crawl (50 yards per 
minute). 

NICE Public Health Guidance 44, 2013 
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10.4 Weekly 
Summary 

The Weekly Summary window can be opened through the 
Tools menu of the Day Analysis window. It shows a graph 
of the wearer’s activity levels over a single week at once: 
 

 
 

Selecting a Week 

The available weeks can be scrolled through in the first 
graphic of the Weekly Summary window. Use the scroll bar 
at the right to move through the weeks and click on the 
one of interest. Alternatively, you can scroll through the 
weeks using the up and down arrows to the right of the 
week calendar, or by using the directional keys on the 
keyboard. 
 
Note that using the Options menu, the weeks can be 
chosen to begin either on Monday (Calendar Week), or on 
the first day of the recording (Consecutive Week). 
 

Weekly Summary Graph 

The main graph in the Weekly Summary window shows 
the time spent in different constant intensity levels on each 
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day of the selected week. You can see both how the time 
each day compares to the target time illustrated by the 
black line, and how it varies across the week. For instance, 
the graphic above clearly shows that whilst the target for 
moderate activity was missed during most of the week, the 
wearer was then very active on Saturday. The View menu 
can be used to turn on and off the highlighting of Low, 
Medium and Vigorous levels. 
 

Weekly Summary Totals 

Below the summary graph, a bar chart illustrates the total 
amounts of time spent in each of Vigorous, Moderate and 
Low activity, and Sedentary time. Along with the graph 
above, this will be updated as the weeks of the recording 
are stepped through. The bar graph also shows the target 
black line, controlled by the weekly exercise target figure 
below it. 
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10.5 Totals & 
Averages 

The Totals & Averages window can be opened through the 
Tools menu of the Day Analysis window. This window is 
designed to illustrate the variation of activity over the full 
length of the recording. The upper graph shows the 
changes between weeks, and the lower graph shows the 
average variation within weeks. 
 

 
 

Weekly Totals 

The upper graph of the Totals & Averages window shows 
the total time spent in different activity bands over the 
weeks of the recording.  In the example shown, the 
recording spanned over 6 weeks and showed relatively 
steady levels apart from an increase in week 4 and a lower 
total in week 6. It is easy to see both the absolute level 
versus the target black line (set at the bottom of the 
window), and the variation between weeks. 
 

Day of Week Averages 

The lower graph of the Totals & Averages window is 
produced by averaging each weekday across all weeks of 
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the recording. This shows up any variation caused by 
weekly patterns of behaviour. In the example shown the 
wearer is clearly far more active on Saturday than on an 
average weekday, but there is more variation within those 
also. 
 
Note that both graphs can be affected by the View and 
Options menus.  The View menu controls whether 
highlights are shown for each of the intensity levels.  The 
Options menu controls whether the discrete weeks are 
considered to always start on a Monday (Calendar Week), 
or on the first day of the recording (Consecutive Week). 
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11 Cloud Data Management (CDM) 
 

11.1 Overview 
Our CDM system allows you to securely manage 
recordings from multiple sites. It is available as an 
additional service which you may add to your account at 
any time. Please contact us to find out more information.  
 
The system uses a HQ and Branch model, where the 
Branch site(s) will upload their data to our cloud server, 
and the HQ site(s) will download the data from our cloud 
server.  
 
All data is encrypted using the encryption keys created at 
your HQ management site, and is completely secure when 
distributed from Branch to Cloud to HQ.  
  
Note: CamNtech has no access to your raw data or 
encryption keys at any time.  
 

11.2 HQ / 
Management 
Site Computer 
Configuration 

To set up your software as a HQ site, click the HQ 
Manager button on the main window to open the HQ 
window as shown below. 
 

 
 

Create Encryption Keys 

Before any data is transferred over the internet, it must be 
encrypted with keys specific to your project. This function 
will allow you to create and store those keys. Click on the 
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HQ Configuration menu and click the Manage 
Encryption Keys menu item. 
 

 
 
Before any branch can be configured, you must click on 
the link to Create New Encryption Keys. Do this now. 
 
When prompted, you should create backup copies of the 
encryption keys to keep in order to prevent loss of data.  If 
you lose the encryption keys, you will lose access to all of 
your data encrypted with them. CamNtech will not be able 
to help you read your encrypted data – we do not have 
copies of your keys. 
 
Close the Encryption Keys window after creating your new 
keys. 
 

Enter Login Information  

You will have been provided with your HQ login 
information by CamNtech as part of your purchase. To use 
this, first click on HQ Configuration  Login 
Information. 
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Enter all of the fields and click on the Save button. This will 
allow the software to connect to the data server as 
necessary. 
 

Sync Folder 

You must also select a folder for the software to store data 
on the HQ computer. Click on HQ Configuration  Set 
Local Sync Folder in the menu to do so. This folder will 
contain all data transferred from the branch sites. 
 
After configuring all of the items above, you may click on 
Sync  Sync Now. This should produce no new data in 
the list, but no error messages either. This is because 
there is no data available yet on the server. Your HQ 
system is now configured. 
 

11.3 Syncing with 
Cloud 

To sync with the Cloud, click the Sync Now menu item in 
the Sync menu. 
 
New recordings will be downloaded and decrypted, with a 
corresponding entry added to the recordings list as shown 
below: 
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These recordings can be opened by selecting them in the 
recordings list and clicking the Sleep Analysis / Day 
Analysis options. 

 

11.4 Branch 
Configuration 
File 

A configuration file is used to automatically configure your 
branch computer(s) to sync recordings with the cloud. The 
configuration file is created by your HQ site computer and 
contains information such as login details and public 
encryption key. 
 
Note: a single configuration file can be used on more than 
one computer per site but we would recommend using one 
configuration file per geographical location.  
 
To create a new configuration file, click the Branch 
Configuration menu found on the HQ Manager window, 
and the click the Create New Configuration File menu 
item. The following window will be shown: 
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Overview of fields: 
 
Site Name: provide a name for the site which the 
configuration file will be used on. 
 
Site Code: provide a site code used to identify the site’s 
recordings when data is synchronised with the HQ site. 
 
Recordings Folder Location: this is location of the 
Recordings Folder Name (see below) on the branch 
computer where the encrypted recordings will be stored 
after they have been downloaded from a MotionWatch. 
 
Recordings Folder Name: this is the name of the folder 
inside the Recordings Folder Location where the encrypted 
recordings will be stored after they have been downloaded 
from a MotionWatch. 
 
Destination File Preview: shows the combined 
Recordings Folder Location and Recordings Folder Name 
and the folder structure within it. 
 
Configuration File Name (without extension): provide a 
file name for the configuration file without an extension. 
 
Configuration File Save Folder: click the Browse… link 
to specify a folder to save the configuration file to.  
 
After providing the necessary information, click the Save 
button to save the configuration file and create the branch 
account on the cloud server. 
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At this stage, you should transfer the configuration file to 
your branch site(s) using your own delivery method (such 
as secure email). 
 

11.5 Branch Site 
Computer 
Configuration 

Ensure you have created a configuration file as discussed 
in section 11.4. 

 
Loading a Configuration File 

 
Open the Cloud Data Configuration window from the 
main window (Menu   Cloud Data Configuration).  
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To load a configuration file, click the Browse… button and 
select your configuration file using the file selection 
dialogue. 
 
The configuration information will be loaded and a 
configuration file and login check will be performed. A 
green tick will be shown next to the Configuration File 
field and one will be shown next to the Login Check field if 
these checks succeed.  
 

Auto-Upload 

The Auto-Upload feature automatically uploads new 
recordings to the cloud immediately after they have been 
downloaded from a MotionWatch.  
 
To turn the feature on or off, click the On/Off buttons. 

 
Clear Settings 

To clear the currently loaded configuration information, 
click the Clear Settings button at the bottom of the 
window. 
 

11.6 Synchronising 
Recordings 
with the Cloud 

If you are using the Auto-Upload feature, recordings will 
automatically be uploaded to the cloud after they have 
been downloaded from a MotionWatch. 
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If previously downloaded recordings were not uploaded 
(such as loss of Internet connection), you can manually 
sync them by clicking the Sync Now button on the 
Settings menu (Main Window  Menu   Sync Now). 
 
The sync indicator will show on the Main Menu: 
 

 
 

Clicking this indicator will open the Sync Status window: 
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Appendix A - Maintenance and Utilities 
 

A1 - The Utilities 
Tab 

The MotionWatch manager has an additional tab called 
‘Utilities’, click on this tab to display a window similar to the 
following: 
 

 
 
This screen shows some technical information about the 
MotionWatch: 
 

 Bootloader Ver: This is the version number of part 
of the embedded operating software that allows the 
MW8 to be updated remotely. 

 Firmware Ver: This is the version number of the 
main operating software for the MW8. 

 Serial Number: The watch serial number 

 Battery voltage: Typically this will show a value 
above 3.0V for a new battery and will decline 
gradually over the usage period. 

 Reset Count: Used as debug information – the 
number of unexpected reset events. 

 Run Time: amount of run time since last battery 
change – should reset to zero when a new battery 
is fitted. 

 Battery Fitted Date: the date that the watch 
battery was fitted. 
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A2 - Firmware 
Update 

The MotionWatch has the ability to be re-programmed 
when new features become available. It is always 
recommended that the most up-to-date firmware and PC 
software are used to avoid possible conflicts and data loss. 
To check for an update, select the ‘Utilities’ tab then click 
on the ‘Check for Update’ button. The software will provide 
a confirmation if an update is available for the 
MotionWatch. 
 
To update the firmware, ensure that the MotionWatch is 
connected and then click on the ‘Update Firmware’ Button. 
Take note of the warning message and click OK if you 
wish to proceed. 
 
IMPORTANT: All data and settings will be destroyed by 
the firmware update process. Please ensure that any data 
has been downloaded before commencing. 
 
WARNING! Do not interrupt the firmware update process – 
doing so may damage the MotionWatch which will then 
require factory re-programming. 
A progress bar will indicate the update progress (this will 
take a few seconds). 
The MotionWatch will then automatically disconnect, apply 
the firmware, then re-connect. The MotionWatch Manager 
window will be temporarily closed during this period and 
will automatically re-load and show a verification message 
upon completion. 
 
Depending upon the type of update, it may be necessary 
to manually re-set the MotionWatch. If the MotionWatch 
Manager does not re-load automatically, disconnect the 
Watch, remove the battery for at least 1 minute, re-fit and 
re-connect the USB. The verification message should then 
be shown. 
 

A3 - Shutdown 
Options 

The MotionWatch has a low power shutdown function 
which will help maximise the life of the battery. In the 
utilities windows, there are two options as follows: 
 

 Auto Shutdown After Download: this option 
allows the MotionWatch to shutdown automatically 
following download. Data in the watch will NOT be 
lost but the watch will stop recording. When not 
selected, the MotionWatch will continue to record 
until its memory is full and then shutdown. 

 Shutdown Watch: Allows the watch to be 
shutdown manually. Click this button to ensure the 
watch will be shut down when disconnected from 
the USB cable. 
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A4 - Changing the 
Battery 

The MotionWatch has been designed to facilitate quick 
and simple battery changing. 
 

 The change the battery, open the MotionWatch 
casing as described in Section 1.1 or 1.2 to expose 
the USB connection and battery.  

 Do not connect the USB cable! 

 Using a suitable tool, carefully push the battery out 
from the holder towards the USB connector. 

 
 
 
 
 
 
 
 
 
 
 
 

 Grasp the battery and withdraw it completely from 
the holder. 

 Wait at least 1 minute or press the marker button 
3 times then place a fresh CR2032 battery into the 
holder (ensuring correct orientation!) and push 
back until fully home. 

 
 

 
 
 
 
 
 
 
 
Note: Data will NOT be lost by removal of the battery. 
 
Observe the LED on the front of the MotionWatch, the 
correct start sequence is indicated as follows: 

 LED stays on for 4 seconds. 

 LED goes off for 8 to 12 seconds. 

 LED flashes once. 
This sequence is critical to the correct watch operation – if 
the LED does not flash, remove the battery and repeat the 
process. 
 
 
The MotionWare software will automatically detect that a 
new battery has been fitted. If the watch contains data that 
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has not been downloaded the following message will be 
displayed: 
 

 
 
Click ‘OK’ and then download the data from the watch. 
 
To complete the battery replacement process a 
confirmation message will be displayed. 
 

 
 
 
Select ‘Yes’ and the software should display 100% in the 
battery life indication. If the new battery is not detected 
remove the battery and repeat the steps above taking time 
to observe each step. If the battery is not replaced 
correctly the watch may stop prematurely with no warning 
and the battery life indicator will be incorrect. 
 

A5 - Waterproof Seal 
The MotionWatch relies upon a rubber O-ring seal around 
the top face of the lower part of the casing. The seal 
should be periodically checked to ensure that it is correctly 
seated, clean and not damaged. (note that some silicone 
grease residue will be apparent – do not remove this). 
Periodically apply a small amount of silicone grease to 
ensure the seal remains supple. 
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A6 - MotionWatch 
Strap 

The MotionWatch is supplied as standard with an extra-
long moulded silicone watch strap. The strap is fitted with 
two standard 12-14mm watch spring bars. These bars are 
spring loaded to allow fitting and removal from the watch 
casing (see photo). 
 
 
 
 
 
 
 
 
 
To remove the Strap: Use a flat bladed tool to gently 
depress one end of the spring bar by levering against the 
side of the casing. Take care not to damage the 
MotionWatch casing. 
 
To Fit a Strap: Push the spring bar into the hole through 
the strap then place one end of the spring bar into one 
hole in the watch casing. Gently depress the exposed end 
of the spring bar and then slide into the hole in the casing; 
a positive ‘click’ will be heard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Replacement straps and alternative straps are available 
from CamNtech. 
 
It is possible to use any standard watch strap with a 12 to 
14mm shoulder with the MotionWatch. 

A7 – Alternative 
Mountings 

The MotionWatch may be worn at locations on the body 
other than the wrist. A range of elasticated straps is 
available to allow location on the waist, ankle, thigh or 
upper arm. There are also special straps for mounting on 
the feet for use with PLMS analysis. These mountings 
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require the removal of the watch strap and the use of 
special Velcro mounting tabs. These attach using the 
same spring bars as the watch straps (see photos). 
 
 

 
 
 
 

 
 
 

A8 – Data Export 
Options 

The MotionWatch data may be exported from for analysis 
in third party applications such as MS Excel. To export all 
of the Activity and light data as time stamped epoch by 
epoch format, first use the ‘Select All’ button from the 
MotionWise window and then choose the ‘Summary’ 
option from the ‘Analysis Function’ side bar. Click on the 
‘Copy raw data’ button to copy the data to the clipboard. 
Now in your external package, select ‘paste’ to paste the 
data from the clipboard. 
It is possible to use this mechanism with all data (as 
explained above) or with any part of the data that is 
selected. Use the ‘Select Any’ or ‘Select Days’ buttons to 
select the data for export and then follow the same steps 
as above. 
It is also possible to ‘bulk export’ data directly into .csv text 
files (see section 2.8). In this way, one folder containing 
multiple data files can be exported directly to multiple text 
format files with a few clicks. 

Fitted to Waist Strap with Adaptor 

Velcro Mounting Tabs Fitted 
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Appendix B – FAQ & Troubleshooting 
 
What does ‘No data integrity 
check’ mean? 

The data is protected by a security key which is generated when 
the data is originally downloaded. Any changes to the data after 
the download (e.g. data corruption, tampering, editing, daylight 
saving adjustment) will result in the data integrity check failure. If 
a deliberate change has been made, the warning can be safely 
ignored. The original data can be restored if required following 
any deliberate edit. 

Will I lose my data if I fit a new 
battery? 

The MotionWatch uses non-volatile memory so any data stored 
will not be lost if the battery is removed or replaced. Note that 
the MotionWatch will automatically shut down when the battery 
voltage is low to prevent erroneous data. Always try to download 
data BEFORE fitting a new battery. If this fails, fit a new battery 
and then download immediately to prevent data loss. 

The MotionWatch is not 
recognised or will not 
communicate: 

Ensure that the battery has sufficient charge. If the battery has 
run down, the watch will not be recognised when attached to the 
USB port. Disconnect from the USB and remove then 
refit/replace the battery (see maintenance section for details of 
battery changing). Wait at least 1 minute before re-fitting the 
battery and observe the correct start-up sequence. 
 

 Some types of Micro USB cable will not make a positive 
connection – please use the cable supplied. 

 Occasionally the cable connector may become damaged 
or worn – try a new USB cable. 

 

The software offers to update 
the MotionWatch firmware – 
what does this mean? 

The MotionWatch Software is shipped with the latest device 
operating firmware. If the software detects that any MotionWatch 
has older firmware, it will inform you that an update is available. 
It is recommended that firmware updates are applied to ensure 
that you benefit any improvements to the device (see 
maintenance section for details of battery changing). 
 

What are the potential effects 
of Electromagnetic 
interference? 

The MotionWatch system was designed to minimise the effects 
of external EMI upon the device and to minimise the effect upon 
the environment from the device. The system conforms to the 
appropriate standards with respect to EMI performance (see 
Appendix   
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C5 - EMC Declaration and Guidance). In cases where strong 
EMI does affect the MotionWatch, the device will recover with no 
user intervention. 
 

Can I change the Watch Strap? 
Yes – see Appendix A6 - MotionWatch Strap above 
 

I see ‘Device setup re-write’ 
message when I apply a new 
set-up 

The MotionWare software will read back the watch set-up and 
verify that it is correct. If the verification fails, the following 
message will be displayed: 
 

  
This indicates that the software is re-trying to write the setup to 
the watch. In most cases the re-try will solve the problem and the 
message will change to the normal setup confirmation message. 
If the setup problem persists then the software will display the 
following warning: 
 

 
 
In this case, click ‘OK’ then disconnect the MotionWatch from the 
USB. Re-run the software, re-connect the watch and re-apply the 
set-up. 
.   
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Appendix C – Safety & Environmental Information 
 

C1 - Decontamination 
 All used devices must be considered to be 

contaminated with surface borne bacteria and must 
hence be de-contaminated using a suitable 
disinfection and cleaning procedure.  

 Care must be taken to use the correct de-
contamination procedure and cleaning materials 
because long term exposure to certain cleaning 
materials is known to attack plastics which can lead 
to premature failure of the mechanical integrity of 
the medical device casing. 

 The MotionWatch casing relies upon maintaining 
the lubrication of the seals and mating surfaces to 
ensure water resistance and to aid opening/closing 
of the casing. 

 CamNtech recommend the use of aqua based 
disinfection products and our recommended 
products are Clinell® Universal Wipes or Spray. 
These products do not contain chemicals known to 
cause deterioration of plastics. 

 Do not use products containing Glutaraldehyde, 
Glucoprotamin, Isopropyl, ethyl, or methyl alcohols, 
hydrogen peroxide, or bleach products. Do not use 
plasma sterilization or ethylene oxide sterilization 
procedures, Do not autoclave. 

 Do not apply self-adhesive labels or tapes to the 
casing. 

 Begin by spraying and/or wiping all visible 
surfaces of the closed MotionWatch body and 
strap with the cleaning agent. Ensure that all 
surfaces are dried before proceeding. Open the 
casing to clean only the areas outside of the 
waterproof seal (see diagrams below). NOTE - it is 
essential not to allow cleaning solutions to enter the 
electronics!  

 Important! – do not clean the O-ring seal as this 
removes the lubricant which can make the casing 
difficult to open and may reduce the water 
resistance. There is no requirement to clean inside 
the waterproof area of the casing (see diagrams 
below). 

 It is advisable to periodically apply a very small 
amount of silicone lubricant to the seal to aid with 
water resistance and to assist opening/closing the 
casing. Contact CamNtech for details of a suitable 
lubricant. 
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Cleaning the lower casing (strap not shown) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Cleaning the upper casing 
 

 
 
 

  

Clean only OUTSIDE of the 
red bounded area – do NOT 
remove the lubrication from 
the O-ring seal. 

Clean only OUTSIDE of the 
red bounded area – do not 
clean the vertical side walls 
and ensure no cleaning agent 
enters the electronics. 
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C2 - Battery 
 The device is battery operated and operates at voltages 

below 5V DC; there is hence no risk from electric shock. 

 The battery is user replaceable (refer to Appendix A4 - 
Changing the Battery). 

 The battery must be replaced observing the correct 
procedure to prevent possible data loss. (refer to 
Appendix A4 - Changing the Battery). 

 The battery is a standard Coin Cell type CR2032. 
Always ensure that the battery used conforms to the 
safety standard EN60086-4:2007. 

 Battery is a swallowing hazard for small children – 
do not leave small children unattended when the 
device casing is open. Take care when handling and 
disposing of coin cell battery. 
 

C3 - Warnings – 
General 

 The MotionWatch is NOT defibrillation proof. 
 

 

C4 - Disposal at End 
of Life 

Waste Electrical & Electronic Equipment (WEEE) The EU 
requires, under the Waste Electrical and Electronic 
Equipment Directive 2002/96/EC that manufacturers 
and/or distributors of Electronic and/or Electrical 
Equipment manage and pay for the collection and further 
handling of WEEE products, as well as provide WEEE-
related information to their customers. CamNtech has 
taken the following approach to complying with this 
Directive: 

 CamNtech has registered with an approved producer 
compliance scheme (PCS) in accordance with the 
requirements of the WEEE Directive. 

 CamNtech will provide free recycling for all of its WEEE 
products when returned to CNT. 

 CamNtech WEEE products will be designed with 
recycling, reuse and waste management as a 
consideration. 

 CamNtech WEEE products will be labelled or stamped 
with the WEEE marking in accordance with European 
Standard EN 50419 
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C5 - EMC 
Declaration and 
Guidance 

The following tables provide a declaration of compliance and 
user guidance regarding Electromagnetic compatibility of the 
MotionWatch system. 
 

Electromagnetic Emissions 
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Electromagnetic Immunity 
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C6 - Applicable 
Standards: 

 

Standard Description 

EN60601-1:2006 Medical electrical equipment – Part 1: General requirements for 
basic safety and essential performance. 

EN60601-1-2:2007 Medical electrical equipment – Part 1-2: Collateral standard: 
Electromagnetic compatibility – Requirements and tests. 

See Appendix C for declaration and guidance  

EN60601-1-11:2010 Medical electrical equipment – Part 1-11: Collateral standard: 
Requirements for medical electrical equipment and medical 
electrical systems used in the home healthcare environment. 

EN60601-1-6:2010 Medical electrical equipment – Part 1-11: Collateral standard: 
Usability 

EN62304:2006 Medical device software – Software life-cycle processes 
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Appendix D – Technical Specifications 

Specifications 

Functional Specifications 

Size mm:   MW 8 36(l) x 28.2(w) x 9.4(d) excluding strap 

   MW-R 42.7(l) x 32.8(w) x 11.5(d) excluding strap 

  Weight: MW 8 9.1 grams (including battery, excluding strap) 

   MW-R 19.5 grams (including battery, excluding strap) 

Sensor: Tri-axial, MEMs technology. 0.01g to 8g range, 3 – 11Hz 

Battery: CR2032 Lithium Coin Cell 

Battery Life: 4 Months run time*; simple user change 

Memory: 4Mbits non-volatile (120 days recording @ 1min epoch - 
uncompressed) 

Waterproof: IPX7  (suitable for swimming) 

Marker button: MW8: Yes – with visual feedback.  MW-R: No 

Epoch: 1, 2, 5, 15, 30, 60 seconds 

Comms: Direct USB, Plug & Play drivers, Micro USB cable. 

Download: All data in 50 seconds approx. 

Strap: Bespoke XL 12mm silicone  (245mm overall length) or 12mm 
nylon. MW-R has various mounting options 

Light Sensor (not fitted to MW-R) 

Type: Digital – human eye response optimized. 

Range: Automatic ranging; 0 to 64000lux 

Resolution: 0.25lux (0-1000 lux range) 

1.00lux (1000-4000 lux range) 

4.00lux (4000-16000 lux range) 

16.0lux (16000 – 64000 lux range) 

Sampling: 1 sample per second – averaged over epoch 

*Applies to MotionWatch Mode, Tri-Axial Mode is 60 days. 

Operating & Storage Conditions 

Complies with the requirements of EN60601-1-11:2010 

 Operating Storage 

Temperature +5°C to + 40°C -25°C to +70°C 

Relative Humidity 0 to 93% 0 to 93% 

Atmospheric Pressure 70kPa to 106kPa 70kPa to 106kPa 
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Accelerometer Processing 

Raw acceleration measurements are processed by the on-board software of the 
MotionWatch to produce a quantitative measure of the activity during each epoch.  
This is a four stage process which is applied to the accelerometer data:   
 

1. The channel perpendicular to the watch is separated and subjected to the 
bandwidth filtering specified above (3-11Hz). 

2. The peak acceleration (either positive or negative) during each second is 
recorded. 

3. This is compared to a minimum “not moving” threshold of approximately 0.1g.  
Values below this threshold are ignored to simplify the final activity graph. 

4. The result from each second is summed over the epoch and scaled to 
produce a standard result in controlled jig testing.  This value is then recorded 
as the MotionWatch count for the epoch. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This process is illustrated in the diagram below, showing the acceleration waveform 
over two epochs, each containing two seconds of data. 
 

 

+35 +40 -25 -30 

one second 

First 2 second epoch 
35 + 40 = 75 

Second 2 second epoch 
25 + 30 = 55 

75 MW counts 55 MW counts 

Sensitive in this 

direction 
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Tri-Axial Mode Data Processing 

This is similar to above except all three axes are utilized to form counts based upon a 
peak vector magnitude. 
 

1. The X, Y and Z axes are sampled with filtering at 3-11Hz. 
2. The peak X2 + Y2 + Z2 value is found per second. 
3. The square root of the sum of squares is calculated and added to the epoch 

sum. 
4. This is compared to a minimum “not moving” threshold of approximately 0.1g.  

Values below this threshold are ignored to simplify the final activity graph. 
5. The values are scaled to produce a ‘Tri-Axial count’ for the epoch. 

 
The diagram below shows the X, Y, Z orientation relative to the watch casing: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MotionWatch XYZ axes: Tri-Axial mode 

Z Axis 

Y Axis 

X Axis 
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Appendix E – Utilities 
 

E1 – CSV Import 
Utility 

To allow import of data recorded with the Actiwatch Spectrum 
or Actiwatch 2, a CSV import utility is provided. Three steps 
are required to import the data: 
 

1. Export the data in CSV format from the Actiware 
Software. 

2. Load the CSV into the utility and perform the 
conversion. 

3. Load the resulting AWD file into MotionWare. 
 
Step 1 – Export the CSV 

 In the Actiware Software, select new analysis and then 
click the Actogram button to show the graph of the 
required data. 

 Next set up the Actiware report generation (you should 
only need to do this once). 

 From the tools menu, select ‘options’ and then click on 
the export tab. Ensure that the ‘full header’ and ‘epoch-
by-epoch list’ options are checked. 

 Now click the ‘data list’ tab and ensure that the ‘activity’ 
option is checked. 

 Click OK to save and close the options window. 

 From the main file menu, select the ‘export…’ option – 
ignore the ‘reminder’ pop-up. 

 You can now choose the file name and location and 
then save the export data as a csv file. 

 
Step 2 – Convert the CSV Data 

 Run the CSV_Import utility from the MotionWare start 
menu: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Click on the ‘Load CSV file’ button. 
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 Browse to locate the CSV file saved in step 1 and click 
‘Open’ 

 The user ID, Gender etc. from the exported CSV file 
should be displayed. 

 Confirm that the recording details are correct in the 
display. 

 If the details are not correct, the export may not be in 
the correct format – please ensure the correct settings 
were applied in Actiware for CSV export. 

 Click ‘Save AWD’ to generate the output file. 
 

Step 3 – Load the AWD File 

 Use the MotionWare software to browse for the AWD 
file created in step 2. (Note you will need to change the 
‘file type’ to .AWD to see the files): 

 
 
 
 
 

 Load the AWD file 

 The data may now be analysed and re-saved as 
required. 

  



MotionWatch & MotionWare User Guide: Issue 1.2.26 Page 88 
 

Document Revision History 
 

Issue 

From 

Issue 

To 

Date Description Initiator 

0.0 1.0 28/05/12 First draft Issue HS 

1.0 1.1 30/05/12 First Issue HS 

1.1 1.2 01/06/12 Added Utilities Tab information to section 8 HS 

1.2 1.3 24/08/12 Added MotionWise view menu options + minor tweaks & additions HS 

1.3 1.4 10/10/12 Corrected MotionWatch counts mode TE 
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